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2 testo 6610 probe 

2.1 Specifications 

2.1.1 Functions and use 
The plug-in, adjusted probes from the testo 6610 range are used in 
conjunction with the testo 6681 humidity transmitter. 

These measuring units are suitable for the following applications, for 
example: 

• Process instrumentation 
• Clean rooms 
• Test benches 
• Drying processes 
• Production and storage air quality 
• Complex room climate applications. 

2.1.1.1 Digital probes: 
The probes are adjusted in the factory and transmit their adjustment data to 
the internal memory of the testo 6681 transmitter. The information is 
transmitted between the probe and transmitter in a purely digital form. The 
probes can therefore be disconnected from the transmitter for adjustment or 
servicing while the transmitter itself can remain at the measuring point.  

 

Hint: 

We recommend in this case that a probe of the same type be 
inserted into the transmitter immediately in order to be able to 
continue measuring with minimal interruption. 

The transmitter identifies the probe and records that a probe was connected 
in the history. 

 

The testo 6681 transmitter cannot be run with the testo 6600 
probes; testo 6610 probes must be used. 
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2.1.1.2 The Testo humidity sensor 
With the Testo humidity sensor, which has been in successful use and 
continually improved for more than twenty years, the focus has from the very 
beginning been on both accuracy parameters, namely measuring uncertainty 
and long-term stability. 

The capacitive humidity sensor is in principle a plate capacitor consisting of 
two electrically conductive plates (electrodes (1) and (2), see diagram below) 
opposite each other.  

A humidity-sensitive polymer (5) serves as the dielectric. The special feature 
lies in the perfect way the individual layers are matched to each other. This is 
evident particularly in the top electrode, which has to perform two tasks that, 
at first glance, appear contradictory: it must be completely permeable to the 
water vapour that is to be fed into the polymer dielectric, but at the same time 
it must be impervious, smooth and repellent to condensate, oil and dirt in 
order to protect the sensor. 

 

 

1 Cover electrode 
2 Bottom electrode  
3 Substrate 

(Ceramic substrate for 
mechanical protection) 

4 Connections 
(protected against corrosion) 

5 Dielectric layer  

 

The humidity sensor cannot be exchanged by the customer. 
The humidity sensor may not be damaged or touched. 
Contamination and damage lead to an impairment of the 
measurement and the measuring accuracy.  
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2.1.1.3 Self-diagnosis 
The probes in the testo 6610 range monitor their functionality themselves and 
report the following faults: 

• Sensor breaks 
• Sensor short-circuit 
• Condensation  
• The condensation message is issued at a reading of 100 % RH and 

deactivated once the readings are within the valid range. 
• Error message with drift at the adjustment points 
• Value for relative humidity less than 0 % RH. 

The trigger threshold is set at -2 % RH. This means that an error 
message is only issued once a clear effect is discernible. 

• Early warning when sensor corrosion is starting to develop 
The testo 6617 probe is able to signal the first signs of corrosion. The 
probe can thus be changed at an early stage without interrupting the 
machine availability. 

• Self-adjustment (testo 6615 only) 
• Excess temperature 

Error message if the permissible process temperature is exceeded 
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2.1.2 Design of the probe 
The probes of the testo 6610 range are made up of the following components 
(included in delivery): 

• Probe connector 
• Probe shaft with protection cap and sensors (% RH and °C or °F) 
• Mounting bracket (for testo 6612 duct version) 
• Probe cable (testo 6612 to 6617, 6622, 6623 duct and cable version), 

bend radius minimum Ø 50 mm 

 

 

 

2.1.3 Accessories 
The following accessories are available for probes in the testo 6610 range: 

• Filters and protection caps (see chapter 2.2.1.4, Filters) 
• Calibration certificates according to ISO and DAkkS (see chapter 4.2, 

Accessories and spare parts). 

Probe 

Probe connector 

Probe length 

Probe 

Protection cap, sensor underneath 
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2.2 Product description 

2.2.1 Overview of probe and filter types 
2.2.1.1 Probe version 

 

A detailed description of the probe versions can be found 
from chapter 2.2.2 onwards. 

The following probe versions are available for the testo 6681 humidity 
transmitter: 

 

Version Article no. Characteristic 
testo 6611 0555 6610-L11 Wall probe version; accuracy to ± 1 % RH; 

temperature range -20 °C to +70 °C/-4 to +158 °F 
testo 6612 0555 6610-L12 Duct probe version; accuracy to ± 1 % RH; 

temperature range -30 °C to +150 °C/-22 to +302 °F 
testo 6613 0555 6610-L13 Cable probe version; accuracy to ± 1 % RH; 

temperature range -70 °C to +180 °C/-94 to +356 °F 
testo 6614 0555 6610-L14 Heated cable probe version; accuracy to ± 1 % RH; 

temperature range -40 °C to +180 °C/ 
-40 to +356 °F 

testo 6615 0555 6610-L15 Trace humidity cable probe version;  
Dew point measurement to -60 °Ctd; temperature 
range -40 °C to +120 °C/-40 to +248 °F 

testo 6617 0555 6610-L17 Cable with cover electrode monitoring probe 
version; accuracy ± 1.2 % RH; temperature range -
40 °C to +180 °C/-40 to +356 °F 



106 testo 6610- 2.2 Product description 

 

2.2.1.2 Determining the accuracy/measuring uncertainty 
The entries for the measuring uncertainty for the probe are determined in 
accordance with GUM (Guide to the Expression of Uncertainty in 
Measurement/DIN V ENV 13005). All parts that make up the measuring 
uncertainty given by Testo are listed below. When comparing the measuring 
uncertainty/accuracy between manufacturers, which components are 
included is to be taken into account. In many cases, not all elements that 
contribute to measuring uncertainty are assessed, for example if the error 
contribution of the production adjustment is shown separately or not at all. 

The measuring uncertainty of the probe includes the sensor and its 
electronics as well as the output of the digital measuring signal: 

1. Linearity including scatter Systematic error and scattering of the 
components (due to manufacturing 
tolerances) 

2. Hysteresis Hysteresis indicates the maximum 
deviation of the readings that are 
obtained when you set the same value for 
the parameter, once coming from a 
smaller value, once coming from a larger 
value (humidity sensors actually have no 
hysteresis, but rather very slow 
adjustment effects that appear to be 
hysteresis when considered only for a 
short period.) 

3. Reproducibility Repeatability (scattering of the readings 
in the event of the same parameter being 
entered successively) 

4. Production adjustment area The measuring uncertainty of the 
reference instruments of the adjustment 
area (including the reference instrument) 
in production 

5. Uncertainty of the testing Uncertainty of the procedure for 
determining points 1 and 2.  
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2.2.1.3 Ordering options for testo 6610 probes (0555 6610) 
Order code  Characteristic  
Lxx Probe type  

L 11 Probe 6611 

L 12 Probe 6612 

L 13 Probe 6613 

L 14 Probe 6614 

L 15 Probe 6615 

L 17 Probe 6617 

Mxx Protective filter  
M 01 Stainless steel sintered filter 

M 02 Metal wire protection cap 

M 03 Sintered PTFE filter 

M 04 Open metal protection cap 

M 05 ABS plastic cap (open) 

M 06 PTFE filter with drip hole 

M 07 PTFE filter with drip hole and condensation protector 

M 08 Filter for H2O2 atmospheres 

Nxx Cable length  

N 00 Without cable (testo 6611) 

N 01 1 m cable length (testo 6613, 6614, 6615, 6617) 

N 02 2 m cable length (testo 6613, 6614, 6615, 6617) 

N 05 5 m cable length (testo 6613, 6614, 6615, 6617,) 

N 10 10 m cable length (testo 6613, 6614, 6615, 6617,) 

N 23 Cable length specifically for duct versions (testo 6612) 

Pxx Probe length  

P 07 Probe length approx. 70 mm (testo 6611) 

P 12 Probe length approx. 120 mm (testo 6613) 

P 20 Probe length approx. 200 mm (testo 6611, 6612, 6613, 6614, 6615, 
6617) 

P 30 Probe length approx. 300 mm (testo 6612, 6613, 6614) 

P 50 Probe length approx. 500 mm (testo 6612, 6613, 6614, 6615, 6617) 

P 80 Probe length approx. 800 mm (testo 6612, 6613) 
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2.2.1.4 Filters 
One of the following filters or protection caps can be used for each probe 
version: 

Filter* Article no.** Characteristic Length A (mm) 
M 01 0554 0647 Stainless steel sintered filter 33 
M 02 0554 0757 Metal wire protection cap 40,3 
M 03 0554 0759 Sintered PTFE filter 35 
M 04 0554 0755 Open metal protection cap 35 
M 05 0192 0265 Open ABS plastic cap 25 
M 06 0554 9913 PTFE filter with drip hole 35 
M 07 0554 9913 + 

0554 0166 
PTFE filter with drip hole and 
condensation protector 

35 
55 

M 08 0554 6000 Filter for H2O2 atmospheres 35 
* When ordering the probe, please use this filter code, cf. chapter 2.2.1.3, Ordering 

options for testo 6610 probes (0555 6610). 
** When purchasing a replacement (filters only), please use this order number 
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2.2.2 testo 6611 wall probe 
The wireless testo 6611 probe is inserted into the testo 6681 humidity 
transmitter that is mounted on the wall and ready-wired. 

At a glance 

 

 

 
Application 

• Monitoring and regulating the production and storage air quality 
when manufacturing and storing hygroscopic products 

• Meeting the top accuracy requirements 
• Clean room applications for which a metal housing is required. 

 

testo 6681 transmitter 

testo 6611 wall probe 

1 Filter (including: humidity 
and temperature sensor) 

2 Probe shaft 
3 Key 
4 Connector 
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Technical Data 
Parameters 
- Humidity (% RH/°Ctd/°Ftd), etc. 
- Temperature 
Measuring range 
- Humidity: 0 to 100 % RH1 
- Temperature: - 20 to 70 °C/-4 to 

+158 °F 
Material 
- Probe shaft: Stainless steel 
- Connector: ABS plastic 
Accuracy (at 25 °C/77 °F)* 
Length 200 mm 
Humidity 
- ± (1.0 % RH + 0.007 x reading) for 

0 to 90 % RH 
- ± (1.4 % RH + 0.007 x reading) for 

90 to 100 % RH 
- 0.02 % RH/K, dependent upon the 

process temperature 
(with a deviation of 25 °C/+77 °F) 

- 0.02 % RH/K, dependent upon the 
electronics temperature 
(with a deviation of 25 °C/+77 °F) 

- Temperature 
- ±0.15 °C (0.27 °F) 
- with slope PT1000 class AA 
* Refer to the charts below for the 

correlation between temperature 
and accuracy. 

- Length 70 mm 
- As with length of 200 mm, but with 

additional measuring error, 
specified for the operating mode 
2 channels at 12 mA, without 
display light, relay off:  

- Humidity: +-1.6 % RH (additional)  
- Temperature: +-0.6 °C (1.1 °F) in 

addition 
 

 
1 For constant use in high humidity (> 80% rF at ≤ 30°C for 
> 12 h, > 60% rF at > 30°C for > 12 h), please contact us via 
www.testo.com/service-contact 

Reproducibility 
- Better than ±0.2 % RH 
Sensor 
Response time without protective 
filter: t 90 max. 15 sec. 
Probe dimensions 
- Diameter of probe shaft: 12 mm 
- E = 55 mm 
- L = approx. 70 mm or 200 mm 
- L – A = 35 mm or 165 mm 
- A, see Table Filters, chapter 

2.2.1.4. 
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Measuring accuracy of testo 6611 wall probe 
Humidity error according to amount |±% RH| as a factor of process humidity 

 

Temperature error as a factor of process temperature and temperature of 
electronics 

 

% RH 

% RH 

System error 6681 + probe, electronics 25 °C/+77 °F 
System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F 
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2.2.3 testo 6612 duct probe 
The testo 6612 probe measures the humidity and temperature in air ducts. 

At a glance 

 

 

 

In the event of overpressures, the probe may become a 
projectile. 

For assembly, see Pressure resistance on the following 
page. 

 
  

1 Filter (including: humidity 
and temperature sensor) 

2 Probe shaft 
3 Wall/duct holder 

(accessories,  
Order no.: 0554 6651) 

4 Mounting bracket 
(permanently joined to 
probe shaft) 

5 Probe cable 
6 Key 
7 Connector 
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Application 
• Monitoring and regulating the production and storage air quality in air 

ducts when manufacturing and storing hygroscopic products 
• Meeting the top accuracy requirements 
• Air duct applications for which a metal housing is required. 

testo 6681 transmitter testo 6612 duct probe 

 

Technical Data 
Parameters 
- Humidity (% RH/°Ctd/°Ftd), etc. 
- Temperature 
Measuring range 
- Humidity: 0 to 100 % RH2 
- Temperature: - 30 to +150 °C/-22 

to +302 °F 
Material 
- Probe shaft: Stainless steel 
- Line: Sheathed, FEP 
- Connector: ABS plastic 
Accuracy (at 25°C/77°F)* 
Humidity 

 
2 For constant use in high humidity (> 80% rF at ≤ 30°C for 
> 12 h, > 60% rF at > 30°C for > 12 h), please contact us via 
www.testo.com/service-contact 

- ± (1.0 % RH + 0.007 x reading) for 
0 to 90 % RH 

- ± (1.4 % RH + 0.007 x reading) for 
90 to 100 % RH 

- 0.02 % RH/K, dependent upon the 
process temperature 
(with a deviation of 25 °C/+77 °F) 

- 0.02 % RH/K, dependent upon the 
electronics temperature 
(with a deviation of 25 °C/+77 °F) 

- Temperature 
- ±0.15 °C (0.27 °F)  
Slope PT1000 class AA 
- * Refer to the charts below for the 

correlation between temperature 
and accuracy. 

Reproducibility 
- Better than ±0,2 % RH 
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Sensor 
Response time without protective 
filter: t 90 max. 15 sec. 
Probe dimensions 
- Diameter of probe shaft: 12 mm 
- L = approx. 200/300/500/800 mm 
- L – A = 165/265/465/765 mm 
- A, see Table Filters, chapter 

2.2.1.4. 

Cable length incl. probe shaft and 
filter 
- Customized for duct version 
Pressure resistance 
- PN 10 (probe tip)** 
** If installing probe under pressure, 

please use cutting ring screw 
connection (order no. 0554 1795). 

 
Measuring accuracy of testo 6612 duct probe 
Humidity error according to amount |±% RH| as a factor of process 
humidity 

 % RH 

% RH 
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Temperature error as a factor of process temperature and temperature of 
electronics 

 
System error 6681 + probe, electronics 25 °C/+77 °F 
System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F 



116 testo 6610- 2.2 Product description 

 

2.2.4 testo 6613 cable probe 
The testo 6613 probe is used when the spatial separation of the transmitter 
and probe is required. 

At a glance 

 

 

 

In the event of overpressures, the probe may become a 
projectile. 

For assembly, see Pressure resistance on the following 
page. 

Application 
• Monitoring and regulating industrial humidity processes (apart from 

high-humidity processes), e.g. food production, storing fruit 

• Monitoring the production and storage air quality when manufacturing 
and storing hygroscopic products 

• Meeting the top accuracy requirements 

• Clean room applications 

• Applications for which a sturdy metal housing is required. 

1 Connector 
2 Key 
3 Probe cable 
4 Probe shaft 
5 Filter (including: humidity 

and temperature sensor) 

1 

2 

3 

5 4 
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We recommend that the testo 6614 (heated) probe be used 
for continuous high-humidity processes. 

testo 6681 transmitter testo 6613 cable probe 

 

Technical Data 
Parameters 
- Humidity (% RH/°Ctd/°Ftd), etc. 
- Temperature 
Measuring range 
- Humidity: 0 to 100 % RH3 
- Temperature: -70 to +180 °C/-94 

to +356 °F 
Material 
- Probe shaft: Stainless steel 
- Line: Sheathed, FEP 
- Connector: ABS plastic 
 
 
 

 
3 For constant use in high humidity (> 80% rF at ≤ 30°C for 
> 12 h, > 60% rF at > 30°C for > 12 h), please contact us via 
www.testo.com/service-contact 

Accuracy (at 25 °C/77 °F)* 
Humidity 
- ± (1.0 % RH + 0.007 x reading) for 

0 to 90 % RH 
- ± (1.4 % RH + 0.007 x reading) for 

90 to 100 % RH  
- 0.02 % RH/K, dependent upon the 

process temperature 
(with a deviation of 25 °C/+77 °F) 

- 0.02 % RH/K, dependent upon the 
electronics temperature 
(with a deviation of 25 °C/+77 °F) 

- Temperature 
- ±0.15 °C (0.27 °F) 
Slope PT1000 class AA 
- * Refer to the charts below for the 

correlation between temperature 
and accuracy. 

Reproducibility 
- Better than ±0,2 % RH 
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Sensor 
Response time without protective 
filter: t 90 max. 15 sec. 
Probe dimensions 
- Diameter of probe shaft: 12 mm 
- L = approx. 120/200/300/500/800 

mm 
- L – A = 85/165/265/465/765 mm 
- A, see Table Filters, chapter 

2.2.1.4. 

Probe length incl. probe shaft and 
filter 
- 1/2/5/10 m 
Pressure resistance** 
- PN 10 (probe tip) 
- PN 1 (if end of probe/cable is 

involved in process) 
** If installing probe under pressure, 

please use cutting ring screw 
connection (order no. 0554 1795). 

Measuring accuracy of testo 6613 cable probe 
Humidity error according to amount |±% RH| as a factor of process humidity 

 

% RH 

% RH 
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Temperature error as a factor of process temperature and temperature of 
electronics 

 
System error 6681 + probe, electronics 25 °C/+77 °F 
System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F 
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2.2.5 testo 6614 heated cable probe 
The testo 6614 heatable probe is suitable for use in high-humidity processes 
in which there is the possibility of condensation for the probe. 

 

Please also see volume 1, chapter 1.3.3.5 for the functional 
principle of the testo 6614. 

At a glance 

 

 

 

In the event of overpressures, the probe may become a 
projectile. 

For assembly, see Pressure resistance on the following 
page. 

1 

2 

3 

1 Connector 
2 Key 
3 Probe cable 
4 Probe shaft 
5 Filter (including: 

humidity and 
temperature sensor) 

6 Cable for temperature 
probe 

7 Temperature probe 
8 Condensation protection 

(0554 0166/0554 0117) 

4 5 

6 7 

8 



testo 6610 - 2.2 Product description 121 

 

Application 
• Monitoring and regulating high-humidity processes, e.g. drying 

(ceramics, tobacco, wood, food) and maturing (cheese, fruit).  

• At flow velocities > 1 m/s, an additional measuring uncertainty, not 
higher than +1.5 % RH, is to be expected. To prevent this error and 
ensure the highest measuring accuracy: Use condensation protector 
0554 0166. 

testo 6681 transmitter testo 6614 heated cable probe 

 

Technical Data 
Parameters 
- Humidity (% RH/°Ctd/°Ftd), etc. 
- Temperature 
Measuring range 
- Humidity: 0 to 100 % RH 
- Temperature: - 40 to +180 °C/-40 

to +356 °F 
Material 
- Probe shaft: Stainless steel 
- Line: Sheathed, FEP 
- Connector: ABS plastic 
 

Accuracy (at 25 °C/77 °F)* 
- Humidity (values valid when used 

with Condensation protector 0554 
0166) 

- ± (1.0 % RH + 0.007 x reading) for 
0 to 100 % RH  

- 0.02 % RH/K, dependent upon the 
process temperature 
(with a deviation of 25 °C/+77 °F) 

- 0.02 % RH/K, dependent upon the 
electronics temperature 
(with a deviation of 25 °C/+77 °F) 

Temperature 
- ±0.15 °C (0.27 °F) 
Slope PT1000 class AA 

Temperature probe 

Assembly 
distance 
max. 10 cm 
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* Refer to the charts below for the 
correlation between temperature 
and accuracy. 

Reproducibility 
- Better than ±0.2 % RH 
Sensor 
Response time without protective 
filter: t 90 max. 15 sec.Probe 
dimensions 
- Diameter of probe shaft: 12 mm 
- Diameter of temp. probe: 3 mm 
- L = approx. 200/500 mm 
- L – A = 165/465 mm 
- A, see Table Filters, chapter 

2.2.1.4. 
Probe length incl. probe shaft and 
filter 
- 1/2/5/10 m 

Pressure resistance** 
- PN 10 (probe tip) 
- PN 1 (if end of probe/cable is 

involved in process) 
** If installing probe under pressure, 

please use cutting ring screw 
connection (order no. 0554 1795). 

 

Measuring accuracy of heated testo 6614 cable probe 
Humidity error according to amount |±% RH| as a factor of process humidity 

 

 

% RH 

% RH 
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Temperature error as a factor of process temperature and temperature of 
electronics 

 
System error 6681 + probe, electronics 25 °C/+77 °F 
System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F 
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2.2.6 testo 6615 trace humidity cable probe (self-
adjustment) 

The testo 6615 probe corrects deviations in measurements by means of self-
adjustment. This has a particular significance with low humidity values (in 
dewpoint range). 

 

Please also see volume 1, chapter 1.3.5.6 for the functional 
principle of the testo 6615. 

Only use testo 6615 with sintered PTFE filter (art. no. 
0554 0759) or sintered stainless steel filter (art. no. 
0554 0647). 

During the self-adjustment phase the signal values of the 
analog outputs remain on hold, meaning they are frozen for 
the duration. 
 

At a glance 

 

 

 

 

In the event of overpressures, the probe may become a 
projectile. 

For assembly, see Pressure resistance on the following 
page. 

1 Connector 
2 Key 
3 Probe cable 
4 Probe shaft 
5 Filter (including: humidity 

and temperature sensor) 

1 

2 

3 

5 4 
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Application 
▪ Monitoring and regulating trace humidity processes (compressed air 

with adsorption or membrane driers and plastic granulate driers) 
▪ Used when spatial separation of transmitter and probe is required. 

testo 6681 transmitter testo 6615 trace humidity cable probe 

 

Technical Data 
Parameters 
- Dewpoint (°Ctd/°Ftd), etc. 
- Temperature 
Measuring range 
- Dewpoint: - 60 to + 30 °Ctd/-148 to 

+212 °Ftd 
- Temperature: - 40 to +120 °C, -40 

to +248 °F 
- (Temp. durability up to +180 

°C/+356 °F) 
Material 
- Probe shaft: Stainless steel 
- Line: Sheathed, FEP 
- Connector: ABS plastic 

Accuracy (at 25 °C/77 °F)* 
Dewpoint 
- ± 1 K at 0 °Ctd/+32 °F 
- ± 2 K at -40 °Ctd/-40 °F 
- ± 4 K at -50 °Ctd/-58 °F 
- ± 6 K at -60 °Ctd/-76 °F 
Dependent on the process 
temperature (deviation of 25 °C/77 °F) 
- ± 0,1 Ktf/K at -40 °C...25 °C/ 

-40 °F...+77 °F 
- ± 0,2 Ktf/K at 25 °C...50 °C/ 

77 ° F...+122 °F 
- ± 0,4 Ktf/K at 50 °C...120 °C/ 

+122 ° F...+248 °F 
Temperature 
- ±0.15 °C (0.27 °F) 
Slope PT100 class AA 
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* Refer to the charts below for the 
correlation between temperature 
and accuracy. 

Sensor 
Response time without protective 
filter: t 90 max. 15 sec. 
Probe dimensions 
- Diameter of probe shaft: 12 mm 
- L = approx. 200/500 mm 
- L – A = 165/465 mm 
- A, see Table Filters, chapter 

2.2.1.4. 

Cable length incl. probe shaft and 
filter 
- 1/2/5/10 m 
Pressure resistance 
- PN 16 (probe tip)** 
** If installing probe under pressure, 

please use cutting ring screw 
connection (order no. 0554 1795). 

Measuring accuracy of testo 6615 trace humidity cable probe 
Dewpoint error according to amount |±% RH| as a factor of process dewpoint 

 

K 

°Ctd 
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Temperature error as a factor of process temperature and temperature of 
electronics 

 
System error 6681 + probe, electronics 25 °C/+77 °F 
System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F 
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2.2.7 testo 6617 cable probe (self-monitoring) 
The testo 6617 probe is used if spatial separation of the transmitter and 
probe is required, particularly for media (gases, vapours) which can 
jeopardize/damage the humidity sensor (the testo 6617 has a self-monitoring 
and early-warning function for such applications). 

At a glance 

 

 

 

In the event of overpressures, the probe may become a 
projectile. 

For assembly, see Pressure resistance on the following 
page. 

Application 
• Monitoring and regulating industrial humidity processes involving 

corrosive media (apart from high-humidity processes) with the 
exception of applications with HCL, HF and other acids and acidifiers 
in larger concentrations (SO2, SO3, NO2) 

• Meeting the top accuracy requirements 
• Applications for which a sturdy metal housing is required. 

1 Stecker 
2 Taste 
3 Fühlerkabel 
4 Sondenrohr 
5 Filter (darunter: Feuchte- 

und Temperatursensor) 

1 

2 

3 

5 4 
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This probe does NOT have a longer life with exposure to 
aggressive media than the testo 6613, for example. However, 
early warning of damage to the sensor is given so that 
machine failures can be avoided. 

2.2.7.1 Self-monitoring of cover electrode 
Use in harsh ambient conditions with aggressive media in some cases incurs 
the risk of damage to the sensor. 

Damage to the sensor is generally reflected by incorrect readings which 
occur a long time before the sensor is wrecked. If this damage to the sensor 
is not spotted until too late, high costs can be incurred due to unusable 
readings or machine shutdowns and waiting times until the sensor is 
replaced. 

 

1 Cover electrode 
2 Bottom electrode  
3 Substrate 

(Ceramic substrate for 
mechanical protection) 

4 Connections 
(protected against corrosion) 

5 Dielectric layer  

 

The testo 6617 has a unique self-monitoring function. This allows early 
detection of damage to the sensor, e.g.: 

• Mechanical damage (e.g. scratches) 
• Damage from aggressive gases (e.g. acids in aerosol form) 
• Welling or detachment of polymer layer due to effects of solvents. 

Once the self-monitoring reaches the specific limit value, the probe warning 
message "Sensor early warning" is issued. 
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testo 6681 transmitter testo 6617 cable probe (self-monitoring) 

 

Technical Data 
Parameters 
- Humidity (% RH/°Ctd/°Ftd) 
- Temperature 
Measuring range 
- Humidity: 0 to 100 % RH4 
- Temperature: - 40 to +180 °C/-40 

to +356 °F 
Material, weight 
- Probe shaft: Stainless steel 
- Line: Sheathed, FEP 
- Connector: ABS plastic 
Accuracy (at 25 °C/77 °F)* 
Humidity 
- ± (1.2 % RH + 0.007 x reading) for 

0 to 90 % RH 
- ± (1.6 % RH + 0.007 x reading) for 

90 to 100 % RH 

 
4 For constant use in high humidity (> 80% rF at ≤ 30°C for 
> 12 h, > 60% rF at > 30°C for > 12 h), please contact us via 
www.testo.com/service-contact 

- 0.02 % RH/K, dependent upon the 
process temperature 
(with a deviation of 25 °C/+77 °F) 

- 0.02 % RH/K, dependent upon the 
electronics temperature 
(with a deviation of 25 °C/+77 °F) 

Temperature 
- ±0.15 °C (0.27 °F)  
Slope PT1000 class AA 
* Refer to the charts below for the 

correlation between temperature 
and accuracy. 

Reproducibility 
- Better than ±0,2 % RH 
Sensor 
Response time without protective 
filter: t 90 max. 15 sec. 
Probe dimensions 
- Diameter of probe shaft: 12 mm 
- L = approx. 200/500 mm 
- L – A = 165/465 mm 
- A, see Table Filters, chapter 

2.2.1.4. 
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Probe length incl. probe shaft and 
filter 
- 1/2/5/10 m 
Pressure resistance 
- PN 10 (probe tip)** 

** If installing probe under pressure, 
please use cutting ring screw 
connection (order no. 0554 1795). 

 
 

Measuring accuracy of testo 6617 cable probe (self-monitoring) 
Humidity error according to amount |±% RH| as a factor of process humidity 

 

Temperature error as a factor of process temperature and temperature of 
electronics 

 

% RH 

% RH 

System error 6681 + probe, electronics 25 °C/+77 °F 
System error 6681 + probe, electronics -25 °C to +70 °C/-13 to +158 °F 
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2.3 Commissioning 

2.3.1 Installing the probe 
2.3.1.1 Installing the testo 6611 wall probe 
The testo 6611 probe (wall version) simply has to be inserted into the socket 
of the testo 6681 transmitter. 

2.3.1.2 Installing the testo 6612 duct probe 
A description of the duct mounting of the testo 6612 probe can be found in 
volume 1, chapter 1.3.2.2. 

2.3.1.3 Installing testo 6613/6614/6615/6617 probes 
If used with these probes, the testo 6681 transmitter is mounted  
on the wall, see volume 1, chapter 1.3.2.1 Commissioning. 

Install probe according to the application and the measuring and 
spatial conditions, cf. cases A1 to C below 

 

In processes with which condensate forms at the humidity 
probe, install the probe vertically (filter points downwards). 

A 1 Wall mounting of probe 

 

 

 

Wall/duct holder 
Order no. 0554 6651 
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A 2 Wall mounting of testo 6614 heated probe 
When mounting the testo 6614 heated probe version, the temperature 
probe must be secured as close to the humidity probe as possible (max. 
10 cm). An appropriate assembly tool is supplied with the testo 6614. 

 

 

 

Wall/duct holder 
Order no. 0554 6651 

Temperature probe 

testo 6614 

Assembly tool, supplied 
with wall/duct holder 
Order no. 0554 6651 

Distance of probe tips of 
humidity probe - temperature 
probe: As close as possible, but 
without touching (Distance 
between probe tips max. 10 cm) 
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B 1 Duct mounting of probe 

 

Engage transmitter in the holder on the 
end of the duct probe 

Only atmospheric processes up to approx. 1 bar positive pressure. 
Alternatively, the single-hole duct holder (order no. 0554 1793) can also be 
used. 

B 2 Duct mounting of testo 6614 heated probe 
When mounting the testo 6614 heated probe version, the temperature 
probe must also be secured at a distance of approximately 10 cm from the 
humidity probe. An appropriate assembly tool is supplied with the 
testo 6614. 

 

 

Wall/duct holder 
Order no. 0554 6651 

Hole ∅ 12.5 mm 

Wall/duct holder 
Order no. 0554 6651 

testo 6614 

approx. 10 cm 
distance 

Temperature probe 

Assembly tool, supplied 
with wall/duct holder 
Order no. 0554 6651 

Direction of flow 
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C Process mounting 

 

 

▪ During installation, ensure that the probe cannot be damaged 
during operation. 

 

For the testo 6614 (heated probe version), please use the 
cutting ring screw connection, order no. 0400 6193, to 
assemble the temperature probe. 

2.3.2 Connecting/removing the probe to/from the 
transmitter 

• Insert probe connector into socket of testo 6681 until it engages. The 
testo 6681 identifies which probe is connected. 

• To remove the probe, the lock release button on the probe must be 
pressed so that this can be removed. 

Cutting ring screw 
connection 
Order no  0554 1795 
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3 Maintenance and cleaning 

3.1.1 Replacing filters/protection caps 
3.1.1.1 Replacing the filter/protection cap for testo 6611 

wall version 

 

 

Do not damage the sensors when exchanging the filter/the 
protection cap and do not touch their surfaces! 

1 Unscrew defective filter/protection cap (2) from probe shaft (1). 
2 Screw new filter/protection cap onto probe shaft. 

 

Screw on protection cap by hand, i.e. do not tighten it using a 
tool. 

 

1 
 
2 



testo 6610 - 2.3 Commissioning 137 

 

3.1.1.2 Replacing the filter/protection cap for testo 6612 
duct version 

 

 

Do not damage the sensors when exchanging the filter/the 
protection cap and do not touch their surfaces! 

 

Hint: 

Mark the insertion length of the probe shaft near the screw 
(11). 

1 Undo screw (11) and pull shaft probe (9) together with 
filter/protection cap (10) from the wall/duct holder (6). 

2 Unscrew defective filter/protection cap from probe shaft and 
screw on new filter/protection cap. 
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Screw on protection cap by hand, i.e. do not tighten it using a 
tool. 

3 Replace O-ring (7) if necessary. Push probe shaft into duct as far 
as the marking and fix position with screw (11). 

3.1.1.3 Replacing the filter/protection cap for cable 
versions 

 

The following descriptions applies to these probes: 

• testo 6613 
• testo 6614 
• testo 6615 
• testo 6617 

 

 

Do not damage the sensor when exchanging the filter/the 
protection cap and do not touch its surface! 

1 Unscrew defective filter/protection cap (2) from probe shaft (1). 
2 Screw new filter/protection cap onto probe shaft. 

 

Screw on protection cap by hand, i.e. do not tighten it using a 
tool. 

1 2 
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3.1.2 Cleaning the instrument and filter/protection cap 
▪ Only clean the instrument carefully with a moist cloth. 
▪ Do not use aggressive cleaning agents. 
▪ Do not use any solvents. 
▪ Unscrew cap or protection cap to clean, clean with compressed air 

and replace. Take care not to damage the sensor! 

3.1.3 Replacing the sensor 
Thanks to the probe concept (digital, plug-in), all probes can be changed in 
situ within seconds if necessary, generally without any interruption to the 
operation of the machine. 

 

To maintain the extremely high accuracy of the testo 6610 
probe, customers are not able to replace the sensor. 

Please contact your Testo Service team for this. 

 



140 P2A software - 4.1 Specifications 

 

4 Parameterizing, adjusting and 
analyzing software (P2A software) 

4.1 Specifications 

The P2A software is used for the parameterizing, adjustment and analysis of 
testo transmitters. The following applies: 

• Generally, all testo transmitters (as of 2007) are supported. 
• For each newly purchased Testo transmitter, a free software upgrade 

must be installed possibly, containing the instrument drivers for all 
transmitters which are connectable at that time. 

• This upgrade can be downloaded free of charge at any time from the 
Testo homepage www.testo.com/download-center (requires 
registration). 

The software must only be bought one time, even for owners of several testo 
transmitters. 

4.1.1 Functions and use 
In the P2A software, two different file types are used: The instrument and the 
parameter file. 

Instrument file 
The parameters of a particular transmitter are stored in its so-called 
instrument file. Using this file, the parameters can be edited and the 
instrument can be tested and adjusted.  

Instrument files also contain the respective histories in addition to the 
parameter data, i.e. "log books" are kept for the previous parameterizations, 
adjustments and messages (see chapter 3.3.5). 

 

Instrument files are ".cfm" format files. 

Parameter file 
Parameter files are not tied to a specific individual transmitter and contain 
only parameter data/no history data. 
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If you use various instruments of the same type, you can create parameter 
files once (e.g. by saving the appropriate instrument file as the parameter file) 
and transmit these onto the other instruments. 

 

Parameter files are ".cfp" format files. 

4.1.2 System requirements  
Operating system 

• Windows® 7 

• Windows® 8 

• Windows® 10 

Computer 
The computer must fulfil the requirements of the respective operating system. 
The following requirements must additionally be fulfilled:  

• Interface USB 1.1 or higher 

• Graphic resolution min. 1024 x 768 

 
Date and time settings are automatically taken over from 
the computer. The administrator must ensure that the 
system time is regularly synchronized with a reliable time 
source, in order to guarantee the authenticity of the data. 

Software 
The P2A software must be purchased and installed separately from the 
transmitter. If it is a new software version, the transmitter is already 
supported completely. Older P2A software versions can be updated via the 
P2A software upgrade. 
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4.1.3 Scope of delivery 
Included in the scope of delivery are: 

• P2A software
• USB driver

When working with the parameterizing, adjusting and 
analyzing software (P2A software), previous knowledge of 
Windows® operating systems is assumed. 

4.2 First steps 

4.2.1 Installing the software/driver 
Adminstrator rights are required for installation. 

4.2.1.1 Installing P2A software 
Without the input of a licence key, the software will run only 
as a demo version (time limit 30 days). 

1 You can download the software under the following link: 
https://www.testo.com/download-center 
 If the installation program does not start automatically: 
> Open download folder and start P2A.exe.

2 Follow the instructions of the installation wizard.  
3 Click on [Finish] to complete the software installation. 

Installing USB driver 
1 You can download the USB driver under the following link: 

 https://www.testo.com/download-center (Testo USB driver) 
  If the installation program does not start automatically: 
> Open download folder and start USBDriver.exe.

2 Follow the instructions of the installation wizard.  
3   Click on [Finish] to complete the software installation. 

https://www.testo.com/software/p2a-software
https://www.testo.com/download-center
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4.2.1.2 P2A software upgrade 
1. Download and store P2A software upgrade from 

www.testo.com/download-center (requires registration). 
2. Select folder into which the downloaded Zip file was stored, 

and unzip the file.  
3. Start file P2A upgrade.exe. 
4. Follow instructions from installation assistant. 

4.2.2 Starting the software 
4.2.2.1 Starting the program 

> Click on All Programs (Windows®7, Windows®8, 
Windows®10) | Testo | P2A- Software.  

 
In Windows Vista/Windows 7 the window User 
account control is opened when starting the 
software the first time.  
> Click on Accept. 

The program window is opened (see chapter 3.3.1). 

4.2.2.2 Establishing a connection with the instrument 
Multiple instruments can be attached, however only one connection is active 
at all times. 

 USB driver is installed (see chapter 3.2.1). 

1 Start the P2A software. 
2 Connect adapter (supplied with the P2A software) to the service 

interface of the instrument (see volume 1, chapter 1.2.4). 
3 Connect instrument/adapter to the PC via the USB interface. 

The instrument file of the attached instrument is shown in the file list. 

4.2.2.3 Activating the connection with the instrument 
 Click on the desired instrument file.  

The selected file is marked in colour and the connection with the 
instrument is activated. 

If a connection with the instrument is established when the program is 
started, the corresponding instrument file is marked automatically.  
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4.3 Using the software 

4.3.1 User interface 

  

1 Menu bar: 
Menu Command Explanation 

File Open Shows the Windows dialogue for searching and 
opening files. 

 Save as Saves the parameters of an instrument or 
parameter file under a new name. 

Edit Copy Copies the parameters of the marked instrument 
or parameter file in the cache. 

 Paste Pastes the parameters from the cache in the 
marked instrument or parameter file. 

View Toolbar 
Status bar 

Activates/deactivates the toolbar or status bar. 

1 
2 
3 
 

4 
 

5 
 

6 
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Menu Command Explanation 

? Check 
instrument 
connections 

Checks the connections to a connected 
instrument without the instrument having to be 
activated. 

 Service A text file with the most important information on 
the computer and the software is opened via 
Display service data. 

 About Shows the version number of the P2A software. 

2 Toolbar: 
Shows the Windows-compliant icons for editing. 

3 File list:  
Icon File Explanation 

 
Instrument 
file 

Instrument file 
Connection to the instrument has been established. 
<Type> <Serial number>.cfm 
File name should not be changed. 

 
Instrument 
file 

Instrument file 
Connection to the instrument has not been 
established. 

 
Parameter 
file 

<Type> <Serial number> <Date> <Time>.cfp  
File name can be changed. 
The name can be selected freely, but it is 
recommended that you retain the reference to the 
instrument. 
Parameter files are always marked red; the parameter 
values they contain are only forwarded to the 
instrument after being transmitted to the instrument 
file. 

4 Function buttons:  
[Change parameterization] see chapter 3.3.2  
[Test/analyze transmitter] see chapter 3.3.3 
[Adjust transmitter] see chapter 3.3.4 
[Transmitter history] see chapter 3.3.5 

Dialogues on editing and testing the instrument are opened by means of 
the buttons. 
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5 File information:  
 Shown in the window 

If an instrument file is 
selected 

Type, serial number, firmware version of the 
instrument or probe. 

If a parameter file is 
selected 

Type, serial number and firmware version of 
instrument for which the parameter file was 
created. 

Connection status Green = connection is active,  
Red = connection is inactive. 

6 Status bar: 
Shows the current status when editing via the menu bar. 

 

4.3.2 Editing instrument/parameter file 
4.3.2.1 Changing instrument/parameter file 
 The desired instrument/parameter file is marked. 

1 Click on [Change parameterization]. 
The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Change parameterization register. 

If the parameters were transmitted from other parameter files into the 
instrument file, a message is shown with which you can transmit the 
new parameters to the connected instrument using [Yes].  

If the parameters should not be transmitted, click on [No].  

2 Change or enter parameters in the corresponding fields. 
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Unit/analog 
output 

Explanation 
All analog outputs are parameterized in this mask. 

 

Unit/analog 
output 
(graphic) 

Unit: 0 to 1 V/5 V/10 V or 4 to 20 mA. 
Vertical: Current version of the analog output (cannot be 
changed). 
Horizontal: Min./max. scale end points of selected unit. 
The curve changes in accordance with the entered value 
of scale minimum and maximum. 

Scale 
minimum/ 
maximum 

The endpoints of the scaling can be selected up to the 
stored scale minimum and maximum. In the process, 
scaling can take place beyond the measuring range in 
order to adjust the analog output to the customer system, 
see volume 1, chapter 1.2.8. 
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Field Explanation 

Unit Selection of the physical unit. 
When changing the unit, standard values are set for scale 
minimum and maximum (see transmitter instruction 
manual for the scale final values). 
Caution! 
When changing the phys. unit, the relay limit values are 
set to the assigned default values. 

Signal delay 
(graphic) 

Curve changes according to the set signal delay. 

Signal delay Time interval in stages of 1 to 15: 
 1 = no delay 
15 = longest delay. 
The signal delay is added to the reaction time of the 
sensor. The signal delay shows averaging over the time 
interval of the selected stage in seconds:  
Example 
Stage 10 = average of the readings from the last 10 
seconds. 

 

The delay of the signal in relation to the change in 
the process is also significantly influenced by the 
selection of the particle filter. 
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Relay limit 
values 1 to 4 

Explanation 
In this mask, the relays or display alarms are 
parameterized  

 

Only have the transmitter wired and connected by 
authorized personnel with the voltage disconnected. 

 

Relay x Four relays are available (optional). 

Not used Relay is not used. 
Hysteresis image and input options are hidden. 

Collective 
alarm 

A relay can be used as a collective alarm detector in the 
event that selected messages appear. See below for 
selection of the messages. 

MIN monitoring If switched to ON (NO contact) or OFF (NC contact) under 
the limit value; in the event of a subsequent exceeding of 
limit value plus hysteresis, it is switched to OFF (NO 
contact) or ON (NC contact). 
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Field Explanation  

MAX 
monitoring 

If switched to ON (NO contact) or OFF (NC contact) 
above the limit value; in the event of a subsequent 
undershooting of limit value minus hysteresis, it is 
switched to OFF (NO contact) or ON (NC contact). 

 

The graphic display in the centre of the screen refers 
to the relay wiring as a NO contact (ON). 

Hysteresis To avoid switching cycles. 

Channel Selection of the channel that is to be monitored. 

Limit value Values for the limits of the unit selected in Unit/analog 
output; 1 decimal place. 
When changing the phys. unit, the relay limit values are 
set to the default values. 
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Collective 
alarm 

Explanation 
Selection of the messages (error, etc.) that should result 
in a collective alarm (OR linkage). 

 

List field with 
checkboxes 

Selection of which messages generated in the 
transmitter should be signalled as the collective alarm 
via the corresponding relay. 

 



152 P2A software - 4.3 Using the software 

 

Basic 
settings 

Explanation 
Setting the absolute pressure and selection of the H2O2 
evaporation process for the parameter °Ctm. 

 

Absolute 
pressure 

The absolute pressure is included in the calculation of the 
following units: 
- °CtdA or °FtdA 
- g/kg or gr/lb 
- ppmV/% vol. 

H2O2 process The calculation of the mixture dewpoint unit °Ctm is 
dependent upon the type of the evaporation process: 
- with passive vaporization: H2O2 solution evaporates ( 

via H2O2 water) 
- with active vaporization: H2O2 solution is evaporated 

over a heated metal plate ( with evaporated H2O2) 
-   Input field: Entering the weight proportion of the liquid 

H2O2 compared to water in %. 
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Ethernet Explanation 
Networking the transmitters via Ethernet. For a multitude 
of applications, measurement data can be simultaneously 
recorded, documented and visualized.  

 

Start wizard... Address allocation for testo 6681 with Ethernet module 
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IP address Transmitter IP address 
 

 

Before the automatic allocation of the IP address, the 
network cable must be connected to the transmitter (see 
Vol 1, Chap. 1.3.4.4). 

If the instrument is being used as a Saveris participant: 

• Saveris Base must be functional. 
• Saveris-Base must be connected to the network.  

 

IP address of 
the device 

Address allocation for testo 6681 with Ethernet module 
 

Manual - Define IP address of the transmitter 
- Enter netmask 
- Enter gateway 

Automatic Automatic allocation of the IP address 
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IP address Saveris base IP address 
 

 

Only when using the transmitter Ethernet modules in 
Saveris mode 

 

IP address of 
the base 

Address allocation of the Saveris base. 
 

Manual - Take IP address from the menu window “InfoBase” of 
the Saveris base 

- Enter IP address 
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Display Explanation 
Setting the display functions (if a display is available on 
the transmitter). 

 

Continuous 
display lighting 

Display lighting is permanently switched on. 

Display lighting 
when button is 
pressed (10 
seconds) 

When a particular button on the instrument is pressed, the 
display lights up for 10 seconds. 

Display 
brightness (0 
to 9) 

Setting the brightness between 0 and 9: 
0 = dark 
9 = light. 

Display 
contrast 
(0 to 9) 

Setting the contrast between 0 and 9: 
0 = lower contrast 
9 = higher contrast. 
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Field Explanation 

Display 
language 

Selection of the language. 

New password The password consists of four numbers, each of which 
must be between 1 and 9.  
If the password protection is not to be used, the numerical 
code "0000" must be entered. 

Adopt new 
password 

Button for confirming the new password. 

Valid password Display of the current password. 

 
Self-
adjustment 

Explanation 
Parameterizing of testo 6615 probe, if this is used. (See 
volume 1, chapter 1.3.3.6 and 2.2.6). 

 

Activate self-
adjustment 

Perform adjustment of testo 6615 probe (auto-
correction). The automatic self-adjustment is 
switched on, which means the probe performs an 
offset adjustment every x hours. The frequency is 
given in hours. 
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Self-
adjustment 
every 

Setting the cycletime in which the self-adjustment is 
to be performed. 

 In order to receive reliable readings during 
the calibration or equalization period of the 
probe, testo recommends the shortest 

possible cycle time. 
A longer cycle time can be set in continous 
operation. 

Start self-
adjustment 

Start self adjustment at a defined time outside the 
cycle time. 

3 Click on [Apply]. 

Changes are saved.  

4.3.2.2 Saving parameters 
Parameters can be saved in new parameter files.  

1 Mark instrument/parameter file 

2 Click on File > Save as in the menu bar. 
3 Select storage location and enter the file name. 

4 Click on [Save]. 

The new parameter file is shown in the file list.  

Only the parameters are saved from an instrument file, the history data 
are not adopted. 

 

The original name (Instrument type, Serial number) is 
suggested with the current date/time as standard, e.g.  
"testo 6681 01234578 061120 1403.cfp".  

For a standard installation, the files are saved under 
"C:\Documents and Settings\All Users\Shared 
Documents\P2A Software". The path can differ depending on 
the version of the operating system. 
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4.3.2.3 Open parameter file 
All parameter files stored in the standard directory path are automatically 
displayed in the file list when the software is started.  

You can also open parameter files that are stored in other directories. 

1 Click on File > Open in the menu bar. 
2 Select the storage location and click on the requisite file. 
3 Click on [Open]. 

The selected file is opened. This can be changed and saved (see 
chapter 3.3.2.2). 

4.3.2.4 Copying and pasting parameters 
The parameters of a parameter file can be transmitted to an instrument file or 
another parameter file from the same instrument type.  

1 Select file whose parameters are to be copied. 
2 Click on Edit > Copy in the menu bar.  
3 Select the file which is to be modified. 
4 Click on Edit > Paste in the menu bar. 

The parameters are transmitted to the file. 

 

You can also use the common keyboard shortcuts for 
copying and pasting, i.e. CTRL C and CTRL V. 

Parameters can also be transmitted using drag & drop, where 
you drag the icon of the parameter file onto the icon of the 
target instrument file.  

4.3.2.5 Deleting instrument/parameter file 
Instrument/parameter files can be deleted from the file list.  

1 Click on the file that is to be deleted with the right mouse button. 
2 Select the command Delete in the context menu. 

The instrument or parameter file is deleted from the list. 



160 P2A software - 4.3 Using the software 

 

4.3.3 Analyzing/testing the transmitter 
In this section, you can test the outputs of the connected instrument, read off 
the limit values and reset the parameters to the factory settings. 

The function is only available for instrument files.  

4.3.3.1 Analyzing/testing the instrument 
 The required instrument file is marked. 

1 Click on [Test/analyze transmitter]. 
The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Test/analyze transmitter register. 

2 Perform action: 
Action Explanation 

Carry out factory 
reset: 

Reset the unit, limit value and hysteresis parameters to 
factory settings (see chapter 3.3.3.2) 

Test analog 
output: 

Test channel 1/2/3 (optional) (see chapter 3.3.3.3). 

Test switch 
outputs: 

Manually switch relays 1 to 4 to test for proper function 
(see chapter 3.3.3.3). 

Min./max. values  
display: 

Overview of the minimum and maximum values 
measured since the last reset of the transmitter (see 
chapter 3.3.3.4). 

3 Click on [OK] or [Cancel] to close the dialogue. 

4.3.3.2 Carry out factory reset 
 The required instrument file is marked. 

1 Click on [Test/analyze transmitter]. 
The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Test/analyze transmitter register. 

2 Mark Transmitter test. 
Current operating hours are shown. 

3 Confirm control query to perform the reset. 
The values are reset to the customer-specific factory settings. 

4 Click on [OK] or [Cancel] to close the dialogue. 
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4.3.3.3 Testing channel 1/2/3 analog output 
 The required instrument file is marked. 

1 Click on [Test/analyze transmitter]. 
The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Test/analyze transmitter register. 

2 Mark channel and test values. 
Field/button Explanation 

Checking the analog outputs (see volume 1, chapter 
1.4.6.6). 

 

Current 
reading 

Readings are updated every second. 

Unit Unit according to the type of analog output. 

Default value Freely definable output value for the respective type of 
analog output (V or mA), 1 decimal place. 
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[Activate] The entered default value is forwarded to the 
corresponding analog output and to the test contacts by 
clicking. 
A warning informs that the value is being transmitted to 
the connected instrument in the event of existing cabling. 
Now check the analog output using a precise multimeter. 

Field/button Explanation 

[Deactivate] Finish entering the electrical variables at the analog 
output. 
The analog output returns to the Current reading again. 

3 Click on [OK] or [Cancel] to close the dialogue. 
The analog output returns to Measuring Mode again. 

4.3.3.4 Testing switch output relays 1 to 4 
 The required instrument file is marked. 

1 Click on [Test/analyze transmitter]. 
The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Test/analyze transmitter register. 

2 Mark Relay tests and test the values. 
Field/button Explanation 

Check the relay function (see volume 1, chapter 1.4.6.6). 
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[Activate relay n] Close contact. 
A warning informs that the value is being transmitted to a 
connected PLC, external display, etc. in the event of 
existing cabling. 

[Deactivate relay n] Open contact. 
A warning informs that the value is being transmitted to a 
connected PLC, external display, etc. in the event of 
existing cabling.  

3 Click on [OK] or [Cancel] to close the dialogue. 
The analog output returns to Measuring Mode again. 

4.3.3.5 Displaying min./max. values 
The transmitter saves the minimum or maximum value for each channel 
(measured since the last voltage supply or since the last manual reset). 

 The required instrument file is marked. 

1 Click on [Test/analyze transmitter]. 
The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Test/analyze transmitter register. 
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2 Mark Min./max. values. 
Field/button Explanation 

View the min./max. values of each channel. 

 

Channel Min./max. of channel 1/2/3 (optional) 

Value Min. or max. value, 1 decimal place. 

Unit Unit selected in Unit/analog output. 

3 Reset Min./max. values. 

4 Click on [Reset the min./max. values]. 
5 Confirm control query to perform the reset. 

The values are reset to the default settings. 

6 Click on [OK] or [Cancel] to close the dialogue. 
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4.3.4 Adjusting the transmitter 
This function is used to adjust an attached instrument. The following 
adjustments may be carried out using the software: 

• 1-point adjustment (offset)  
• 2-point adjustment (upper and lower adjustment point) 
• Analog adjustment (entry via assistant/wizard). 

Also see volume 1, chapter 1.3.3 for this. 

4.3.4.1 1-point adjustment 
1 Expose the reference measuring instrument and the instrument to be 

adjusted to the same constant conditions and wait for equalization 
period to lapse. 

2 Mark the instrument file of the connected instrument.  
3 Click on [Adjusting the transmitter]. 

The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Adjusting the transmitter register. 

4 Enter reference value and click on [Carry out 1-point adjustment]. 
5 Confirm confirmation request 

The adjustment is carried out. 
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Field Explanation 

 

°C/°F Selection of the unit; only for temperature adjustment. 

Current 
reading 

Reading in °C/°F or % RH. 
Readings are updated every second. 

Reference 
value 

Entry of the read-off value from the reference measuring 
instrument. 
Permissible entries:  
max. 5 % RH deviation  
max. 2 K (°C) deviation  

 Click on [Set offset to zero] to reset a transmitted reference value. 
The current reading is used again. 

6 Click on [OK] or [Cancel] to close the dialogue. 
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4.3.4.2 2-point adjustment 

 

Also see volume 1, chapter 1.3.3.3. 

1 Expose the reference measuring instrument and the instrument to be 
adjusted to the same constant conditions and wait for equalization 
period to lapse. 

2 Mark the instrument file of the connected instrument.  
3 Click on [Adjusting the transmitter]. 

The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Adjusting the transmitter register. 

4 Mark 11.3 %, enter the reference value for the lower adjustment point 
and click on [Lower adjustment point]. 
The adjustment is carried out. 

5 Mark 75.3 %, enter the reference value for the upper adjustment point 
and click on [Upper adjustment point]. 
The adjustment is carried out. 
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Field Explanation 

 

Actual reading Reading in % RH. 
Readings are updated every second. 

Reference 
value 

Entry of the read-off value from the reference measuring 
instrument. 
Permissible entries:  
Lower adjustment point 10.3 to 12.3 % RH  
Upper adjustment point 74.3 to 76.3 % RH. 

6 Click on [OK] or [Cancel] to close the dialogue. 
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4.3.4.3 Adjusting the analog output 
1 Connect precision multimeter (see volume 1, chapter 1.3.3.4). 
2 Mark the instrument file of the connected instrument. 
3 Click on [Adjusting the transmitter]. 

The Properties of <Instrument type> <Serial number> dialogue is 
opened with the Adjusting the transmitter register. 

4 Click on [Start wizard…] and follow the instructions of the wizard. 
The adjustment is performed when the wizard is closed. 

Field Explanation 

 

Default value The analog output value is given at the output: 

Lower adjustment point:  10 % of the max. value 

Centre adjustment point:  50% of the max. value 

Upper adjustment point:  90 % of the max. value. 

Measured 
analog value 

Required field: 
Entry of the value read off at the multimeter. 
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4.3.5 Transmitter history 
Parameterizations, adjustment processes and messages that have occurred 
are registered in the transmitter with an operating hours stamp. 

In the history overviews (explained later in more detail), past processes and 
events can be made visible. 

 

For parameter changes or adjustments that are performed 
directly at the instrument (via the user menu), "Transmitter" is 
entered in the User field and only the operating hour is 
entered in the Date/time field instead of operating 
hour/date/time. 

For entries that are performed using the P2A software, the 
name of the user logged into Windows appears in the User 
field, while the operating hour is shown in the Date/time field. 

1 Mark the instrument file of the connected instrument.  
2 Click on [Transmitter history] button. 

The "Properties of <Instrument type> <Serial number>" dialogue is 
opened with the Transmitter history register. 

3 Click on the required entry in the list to change the display. 
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Parameteri-
zation history 

Explanation 

 

Date/time Format of the PC time is adopted from the settings of the 
operating system. 

User Name with which the user is logged into the operating 
system. 
"MUF" (= transmitter) if the change was performed at the 
instrument. 

Operating 
hours/date/time 

Operating hour/time stamp at which the change at the 
instrument was performed.  

Comments Type of parameter change, 
e.g. "Unit of channel 2 from °F to °C". 
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Adjustment 
histories 

Explanation 

 

Selection: 1-point adjustments/2-point adjustments/Analog 
adjustments. 

Date/time Format of the PC time is adopted from the settings of 
the operating system. 

User Name with which the user is logged into the operating 
system. 
"MUF" (= transmitter) if the change was performed at 
the instrument. 

Operating 
hours/date/time 

Operating hour/time stamp at which the change at the 
instrument was performed. 

Serial no. Probe Serial number of the probe. 

Reference value If no changes were performed, no value is displayed. 
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Column Explanation 

Unit Unit during the adjustment. 

Actual value 
before 
adjustment 

1-point adjustment: If no changes were performed, no 
value is displayed. 

Offset from 1-point adjustment: Value before the adjustment. 

Offset to 1-point adjustment: Value after the adjustment. 

Offset 2-point adjustment: Difference between target and 
actual value reported by instrument. 

Channel Analog adjustment: Channel 1 to n. 

Specification Analog adjustment: Actual value. 

Reading Analog adjustment: Reference value entered. 

Offset Analog adjustment: Deviation at time of adjustment. 
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Error/status 
messages 

Explanation 

 

The table is shown only for error and status messages that were generated 
in the transmitter and were transferred and saved there via the connection 
to the P2A software. 

Date/time Format of the PC time is adopted from the settings of the 
operating system. 

Operating 
hours 

Operating hour at which the message appeared in the 
instrument. 

User "MUF" (= transmitter) because the message was 
generated in the transmitter. 

Message e.g. "Wrong probe". A non-compatible probe was 
connected. 

Type of 
message 

e.g. early warning, status message. 
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To print out the history data, click on [Print]. 

 

The printing job is automatically sent to the default printer for 
the operating system. 

The printout can be edited using [Set up printer…].  

4 Click on [OK] or [Cancel] to close the dialogue. 
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5 Tips and assistance 

5.1 Questions and answers 

Question Possible causes/solutions 
Connection to instrument cannot be 
established 

Check connection cable/plug contacts 

A message appears on the display See volume 1, chapter 1.5. 
Malfunction (with or without display) Analysis using the P2A software, see 

chapter 3.3.3. 
Undo adjustment A 1-point temperature/humidity adjustment 

can be reset to the current reading using 
[Set offset to zero]. 
The actual values before the adjustment 
can be read out from the corresponding 
history table. 
2-point adjustments and analog 
adjustments can only be undone by means 
of a factory reset. 

When does a stable current reading 
appear? 

After approx. 20 seconds 

 
If we could not answer your question, please contact your dealer or Testo 
Customer Service. For contact data, see back of this document or web page 
www.testo.com/service-contact. 
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5.2 Accessories and spare parts 

 

An overview of the probes that can be used with the 
testo 6681 can be found in volume 1, chapter 1.2.2. 

 

Designation Article no. 
Ethernet 
Ethernet module 0554 6656 
Ethernet plug 0554 6653 
Interface and software 
P2A software (parameterizing, adjusting, analyzing) incl. USB 
adapter 

0554 6020 

Fastenings, assembly aids 
Wall/duct bracket with M3 screw for fastening the transmitter to the 
probe and the probe to the wall/duct 

0554 6651 

Pressure-tight G 1/2" screw connection with cutting ring up to 16 bar 0554 1795 
Pressure-tight G 1/2" screw connection with PTFE ring up to 6 bar 0554 1796 
Plug-in connections  
Set of M12 plug-in connections (connector and socket) for power 
and signal lines 

0554 6682 
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Designation Article no. 
Dewpoint measurement (only with testo 6615)  
Preliminary filter to protect measurement chamber and sensors 
against contamination 

0554 3311 

Precision chamber with adjustable inflow 0554 3312 

Sensor filters and protective caps 
Stainless steel sintered filter 0554 0647 
Wire mesh filter 0554 0757 
Sintered PTFE filter 0554 0759 
Protection cap made of metal (open) 0554 0755 
PTFE protection cap with drip hole 0554 9913 
Condensation protector 0554 0166 
Filter for H2O2 atmospheres 0554 6000 
H2O2 protection cap 0699 5867/1 
Adjustment equipment 
Humidity adjustment set (11.3/75.3 % RH) 0554 0660 
Extension and calibration cable 0554 6610 
Supply 
Mains unit (desktop, wall-mounted) 0554 1748 
Mains unit (top-hat rail mounting) 0554 1749 
Calibration 
Standard ISO calibration certificate, transmitter + probes 0520 0176 
Special ISO calibration certificate, transmitter + probes 0520 0066 
Standard DAkkS calibration certificate, transmitter + probes 0520 0276 
Special DAkkS calibration certificate, transmitter + probes 0520 0236 
ISO calibration certificate humidity, probes 0520 0076 
DAkkS calibration certificate temperature, probes 0520 0261 
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5.2.1 Ordering options for testo 6681 transmitter 
(0555 6681) 

Order code  Characteristic  
Axx  
Version 

 

A01 Currently no further selection of variants 
Bxx Analog 
output 

 

B02 0 to 1 V (4-wire, 24 VAC/DC) 
B03 0 to 5 V (4-wire, 24 VAC/DC) 
B04 0 to 10 V (4-wire, 24 VAC/DC) 
B05 0 to 20 mA (4-wire, 24 VAC/DC) 
B06 4 to 20 mA (4-wire, 24 VAC/DC) 
Cxx  
Display 

 

C00 without display 
C02 with display/English 
C03 with display/German 
C04 with display/French 
C05 with display/Spanish 
C06 with display/Italian 
C07 with display/Japanese 
Dxx Cable entry  
D01 M16 PG screw connection (with relay, also M20) 
D02 Cable entry NPT 1/2" 
D03 Plug-in connections for power and signal lines 
Exx 
Ethernet module 

 

E00 without Ethernet module 
E01 with Ethernet module 
Fxx  
Channel 1 Unit 

 

F01 % RH/Min/Max 
F02 °C/Min/Max 
F03 °F/Min/Max 
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Order code  Characteristic  
F04 °Ctd/Min/Max 
F05 °Ftd/Min/Max 
F06 g/kg /Min/Max 
F07 gr/lb /Min/Max 
F08 g/m3/Min/Max 
F09 gr/ft3/Min/Max 
F10 ppmVol/min/max 
F11 °Cwb/Min/Max (wet bulb) 
F12 °Fwb/Min/Max (wet bulb) 
F13 kJ/kg /Min/Max (enthalpy) 
F14 hPa /Min/Max (water vapour partial pressure) 
F15 inch H2O/Min/Max (water vapour partial pressure) 
F18 % Vol / min / max 
Gxx  
Channel 2 Unit 

 

G01 % RH/Min/Max 
G02 °C/Min/Max 
G03 °F/Min/Max 
G04 °Ctd/Min/Max 
G05 °Ftd/Min/Max 
G06 g/kg /Min/Max 
G07 gr/lb /Min/Max 
G08 g/m3/Min/Max 
G09 gr/ft3/Min/Max 
G10 ppmVol/min/max 
G11 °Cwb/Min/Max (wet bulb) 
G12 °Fwb/Min/Max (wet bulb) 
G13 kJ/kg /Min/Max (enthalpy) 
G14 hPa /Min/Max (water vapour partial pressure) 
G15 inch H2O/Min/Max (water vapour partial pressure) 
G18  % Vol / min / max 
Hxx  
Relay 

 

H00 without relay 
H01 4 relay outputs, limit value monitoring 
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Order code  Characteristic  
H02 4 relay outputs, channel 1 limit values and collective alarm 
Ixx 
Optional 3rd 
analog output 

 

I00 no optional 3rd analog output 
I01 % RH/Min/Max 
I02 °C/Min/Max 
I03 °F/Min/Max 
I04 °Ctd/Min/Max 
I05 °Ftd/Min/Max 
I06 g/kg /Min/Max 
I07 gr/lb /Min/Max 
I08 g/m3/Min/Max 
I09 gr/ft3/Min/Max 
I10 ppmVol/min/max 
I11 °Cwb/Min/Max (wet bulb) 
I12 °Fwb/Min/Max (wet bulb) 
I13 kJ/kg /Min/Max (enthalpy) 
I14 hPa /Min/Max (water vapour partial pressure) 
I15 inch H2O/Min/Max (water vapour partial pressure) 
I16 °Ctm (H2O2 mixture dewpoint) 
I17 °Ftm (H2O2 mixture dewpoint) 
I 18 % Vol / min / max 
I19 %RHm (mixture humidityfor H202) 
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5.2.2 Ordering options for testo 6610 probes 
(0555 6610) 

Order code  Characteristic  
Lxx  
Probe type 

 

L 11 Probe 6611 
L 12 Probe 6612 
L 13 Probe 6613 
L 14 Probe 6614 
L 15 Probe 6615 
L 17 Probe 6617 
Mxx  
Protective filter 

 

M 01 Stainless steel sintered filter 
M 02 Metal wire protection cap 
M 03 Sintered PTFE filter 
M 04 Open metal protection cap 
M 06 PTFE filter with drip hole 
M 07 PTFE filter with drip hole and condensation protector 
M 08 Filter for H2O2 atmospheres 
Nxx  
Cable length 

 

N 00 Without cable (testo 6611) 
N 01 1 m cable length (testo 6613, 6614, 6615, 6617) 
N 02 2 m cable length (testo 6613, 6614, 6615, 6617) 
N 05 5 m cable length (testo 6613, 6614, 6615, 6617) 
N 10 10 m cable length (testo 6613, 6614, 6615, 6617) 
N 23 Cable length specifically for duct versions (testo 6612) 
Pxx  
Probe length 

 

P 07 Probe length approx. 70 mm (testo 6611) 
P 12 Probe length approx. 120 mm (testo 6613) 
P 20 Probe length approx. 200 mm (testo 6611, 6612, 6613, 6614, 

6615, 6617) 
P 30 Probe length approx. 300 mm (testo 6612, 6613, 6614) 
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Order code  Characteristic  
P 50 Probe length approx. 500 mm (testo 6612, 6613, 6614, 6615, 

6617) 
P 80 

Probe length approx. 800 mm (testo 6612, 6613) 
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